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m Introduction

This guide provides reference information for the use of MC Test Run IAG library. It does not provide
safety information.

Be sure to obtain the NA-series Programmable Terminal User's Manuals, read and understand the
safety points and other information required for use, and test sufficiently before actually using the
equipment.

Sysmac and SYSMAC are trademarks or registered trademarks of OMRON Corporation in Japan
and other countries for OMRON factory automation products.

Other company names and product names in this document are the trademarks or registered
trademarks of their respective companies.

Microsoft product screen shots are reprinted with permission from Microsoft Corporation.



Terms and Conditions Agreement

Warranty, Limitations of Liability

I Warranties

® Exclusive Warranty

Omron’s exclusive warranty is that the Products will be free from defects in materials and
workmanship for a period of twelve months from the date of sale by Omron (or such other period
expressed in writing by Omron). Omron disclaims all other warranties, express or implied.

® Limitations

OMRON MAKES NO WARRANTY OR REPRESENTATION, EXPRESS OR IMPLIED,
ABOUT NON-INFRINGEMENT, MERCHANTABILITY OR FITNESS FOR A PARTICULAR
PURPOSE OF THE PRODUCTS. BUYER ACKNOWLEDGES THAT IT ALONE HAS
DETERMINED THAT THE PRODUCTS WILL SUITABLY MEET THE REQUIREMENTS OF
THEIR INTENDED USE.

Omron further disclaims all warranties and responsibility of any type for claims or expenses
based on infringement by the Products or otherwise of any intellectual property right.

® Buyer Remedy

Omron’s sole obligation hereunder shall be, at Omron’s election, to (i) replace (in the form
originally shipped with Buyer responsible for labor charges for removal or replacement
thereof) the non-complying Product, (ii) repair the non-complying Product, or (iii) repay or
credit Buyer an amount equal to the purchase price of the non-complying Product; provided
that in no event shall Omron be responsible for warranty, repair, indemnity or any other
claims or expenses regarding the Products unless Omron’s analysis confirms that the
Products were properly handled, stored, installed and maintained and not subject to
contamination, abuse, misuse or inappropriate modification. Return of any Products by
Buyer must be approved in writing by Omron before shipment. Omron Companies shall not
be liable for the suitability or unsuitability or the results from the use of Products in
combination with any electrical or electronic components, circuits, system assemblies or any
other materials or substances or environments. Any advice, recommendations or
information given orally or in writing, are not to be construed as an amendment or addition to
the above warranty.

See http: //www.omron.com/global/ or contact your Omron representative for published
information.

I Limitation on Liability; Etc

OMRON COMPANIES SHALL NOT BE LIABLE FOR SPECIAL, INDIRECT, INCIDENTAL,
OR CONSEQUENTIAL DAMAGES, LOSS OF PROFITS OR PRODUCTION OR
COMMERCIAL LOSS IN ANY WAY CONNECTED WITH THE PRODUCTS, WHETHER
SUCH CLAIM IS BASED IN CONTRACT, WARRANTY, NEGLIGENCE OR STRICT
LIABILITY.

Further, in no event shall liability of Omron Companies exceed the individual price of the
Product on which liability is asserted.




Application Considerations

I Suitability of Use

Omron Companies shall not be responsible for conformity with any standards, codes or
regulations which apply to the combination of the Product in the Buyer’s application or use
of the Product. At Buyer’s request, Omron will provide applicable third party certification
documents identifying ratings and limitations of use which apply to the Product. This
information by itself is not sufficient for a complete determination of the suitability of the
Product in combination with the end product, machine, system, or other application or use.
Buyer shall be solely responsible for determining appropriateness of the particular Product
with respect to Buyer’s application, product or system. Buyer shall take application
responsibility in all cases.

NEVER USE THE PRODUCT FOR AN APPLICATION INVOLVING SERIOUS RISK TO
LIFE OR PROPERTY WITHOUT ENSURING THAT THE SYSTEM AS A WHOLE HAS
BEEN DESIGNED TO ADDRESS THE RISKS, AND THAT THE OMRON PRODUCT(S) IS
PROPERLY RATED AND INSTALLED FOR THE INTENDED USE WITHIN THE OVERALL
EQUIPMENT OR SYSTEM.

I Programmable Products

Omron Companies shall not be responsible for the user’s programming of a programmable
Product, or any consequence thereof.

Disclaimers

I Performance Data

Data presented in Omron Company websites, catalogs and other materials is provided as a
guide for the user in determining suitability and does not constitute a warranty. It may
represent the result of Omron’s test conditions, and the user must correlate it to actual
application requirements. Actual performance is subject to the Omron’s Warranty and
Limitations of Liability.

I Change in Specifications

Product specifications and accessories may be changed at any time based on
improvements and other reasons. It is our practice to change part numbers when published
ratings or features are changed, or when significant construction changes are made.
However, some specifications of the Product may be changed without any notice. When in
doubt, special part numbers may be assigned to fix or establish key specifications for your
application. Please consult with your Omron’s representative at any time to confirm actual
specifications of purchased Product.

I Errors and Omissions

Information presented by Omron Companies has been checked and is believed to be
accurate; however, no responsibility is assumed for clerical, typographical or proofreading
errors or omissions.
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1 Related Manuals

The following manuals are related to this guide.

Cat. No.

Model

Manual name

V117

NAS-15WT00
NAS-12W(l00
NAS-9W0
NAS-7WT[

NA-series Programmable Terminal Hardware User's Manual

V118

NAS-15WT00
NAS-12W(l00
NAS-9W0
NAS-7WT0

NA-series Programmable Terminal Software User's Manual

V119

NAS-15WII0N
NAS-12W00
NAS-OWN
NAS-7WI(00

NA-series Programmable Terminal Device Connection User’s
Manual

V120

NAS-15WII0N
NAS-12WI00
NAS-OWN
NAS-7WI[00

NA-series Programmable Terminal Startup Guide

W505

NX701-1[{0
NJ501-1[]01]
NJ301-1[]01]
NJ101-10[][]

NJ/NX-series CPU Unit Built-in EtherCAT® Port User's Manual

W507

NX701-1{]0[]
NJ501-1[](I[]
NJ301-1[]II]
NJ101-10[][]

NJ/NX-series CPU Unit Motion Control User's Manual

1576

R88M-K]]

(AC Servomotors)
R88D-KN[-ECT
(Servo Drives)

AC Servomotors/Servo Drives
Gb-series
(Built-in EtherCAT® Communications) User's Manual

1586

R88M-1L[)/-1M[]

(AC Servomotors)
R88D-1SN[-ECT
(AC Servo Drives)

AC Servomotors/Servo Drives
1S-series
(Built-in EtherCAT® Communications) User’'s Manual

W504

SYSMAC-SE2[I[II]

Sysmac Studio Version 1 Operation Manual




2 Precautions

(1)When building an actual system, check the specifications of the component devices of
the system, use within the ratings and specified performance, and implement safety
measures such as safety circuits to minimize the possibility of an accident.

(2) For safe use of the system, obtain the manuals of the component devices of the system
and check the information in each manual, including safety precautions, precautions for
safe use.

(3) It is the responsibility of the customer to check all laws, regulations, and standards that
the system must comply with.

(4)All rights reserved. No part of this publication may be reproduced, stored in a retrieval
system, or transmitted, in any form, or by any means, mechanical, electronic,
photocopying, recording, or otherwise, without the prior written permission of OMRON.

(5) The information in this guide is current as of June 2016.

No patent liability is assumed with respect to the use of the information contained herein.
Moreover, because OMRON is constantly striving to improve its high-quality products,
the information contained in this guide is subject to change without notice.

(6) The operation of each IAG has tested using the device configuration indicated in this
guide. However, the operation of screens after incorporating the IAG is not guaranteed.

Special information in this document is classified as follows:

@ Precautions for Safe Use

Indicates precautions on what to do and what not to do to ensure safe usage of
the product.

Ifl Precautions for Correct Use

Indicates precautions on what to do and what not to do to ensure proper operation
and performance.

E% Additional Information

Additional information to read as required.
This information is provided to increase understanding or make operation easier.

Copyrights and Trademarks

Screenshots are used in accordance with Microsoft Corporation guidelines.
Windows is a registered trademark of Microsoft Corporation in the USA and other
countries.

EtherCAT® is registered trademark and patented technology, licensed by Beckhoff
Automation GmbH, Germany.

Company names and product names in this document are the trademarks or
registered trademarks of their respective companies.




3 Introduction

NJ user programs and HMI displays are modularized as function blocks (FB) and IAGs that
are required to implement the MC Test Run of the Sysmac Studio on the HMI.
Combining the FB and IAG allows you to implement the following displays faster and easier.

® Test Run screen for motion axis
® Pop-up page for axis manual operation and sensor adjustment

]
]
Monitor IAG :\A%nltor
Combine any &OGIT;bIne any
IAGs
Control IAG Control
I1AG

You can easily create Test Run
screen.

You can easily create pop-up
page.




3-1 Applicable Model

Item Name Model Version
Automation Sysmac Studio SYSMAC-SE[I V1.14 or later
software 1)

Device Programmable Terminal NA5-15WII[00 V1.03 or later

NAS-12WI[(][]
NAS-9WII(]
NAS-7W0(

CPU Unit

NJS01-{JI00
NJ301-[]I00
NJ101-10([]

V1.11 or later

AC Servo Drives G5-series
(Built-in EtherCAT® Communications)

R88D-KN[-ECT

AC Servo Drives 1S-series

R88D-1SN[J-ECT

(Built-in EtherCAT® Communications)

*1) Sysmac Studio V1.16 or later can be used for AC Servo Drives 1S-series.

Eﬂ Additional Information
Restrictions on the use of each product above may be described in other manuals.

Refer to Section 1 Related Manuals (P7).

3-2 Object Configuration

The Test Run IAG and FB libraries consist of the following objects;
IAG object : 15 objects (5 types for pop-up page, 7/ 9 inch full-screen, and 12/ 15 inch

full-screen, respectively)

Function Block : 2 FBs

Type

Description

Detail

IAG library file (for Popup page)
File name: DeviceWindowlAG_114A_E_MCTest Run_Popup.iag

IAG library files for pop-up and small-sized

screens.

IAG

Axis status monitor_(Pop-up)

Displays the Servo ON/OFF and its status.

IAG

Jog feed_(Pop-up)

Sets the parameter for Jog feed and

performs the operation.

IAG

Absolute positioning_(Pop-up)

Sets the parameter for absolute positioning

and performs the operation.

IAG

Relative positioning_(Pop-up)

Sets the parameter for relative positioning

and performs the operation.

IAG

Homing_(Pop-up)

Performs the homing.

IAG library file (for 7/ 9 inches)
File name: DeviceWindowlAG_114A _E_MCTest Run_9inch.iag

IAG library files for 7/ 9 inch full-screen.

IAG

Axis status monitor_(Full-screen)

Displays the Servo ON/OFF and its status.

IAG

Jog feed_(Full-screen)

Sets the parameter for Jog feed and
performs the operation.

IAG

Absolute positioning_(Full-screen)

Sets the parameter for absolute positioning
and performs the operation.

IAG

Relative positioning_(Full-screen)

Sets the parameter for relative positioning
and performs the operation.
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IAG | Homing_(Full-screen)

Performs the homing.

IAG library file (for 12/ 15 inches)
File name: DeviceWindowlAG_114A_E_MCTest Run_12inch.iag

IAG library files for 12/ 15 inch full-screen.

IAG Axis status monitor_(Full-screen) Displays the Servo ON/OFF and its status.

IAG Jog feed_(Full-screen) Sets the parameter for Jog feed and
performs the operation.

IAG Absolute positioning_(Full-screen) Sets the parameter for absolute positioning
and performs the operation.

IAG Relative positioning_(Full-screen) Sets the parameter for relative positioning
and performs the operation.

IAG Homing_(Full-screen) Performs the homing.

Axis Information Acquire FB
File name: IAGCont DeviceWindow ReadDeviceName V1 O0.sir

FB library file that acquires the axis
information.

Function Block Acquires axis information.

FB that acquires the axis information with
SDO.

Manual Operation FB
File name: IAGCont_DeviceWindow MCTest Run_V1_0.sir

FB library file that performs manual

operation.

Function Block | Performs manual operation.

FB that performs manual operation.

We also provide the following Excel file that simplifies a declaration of NJ variables.

e  Excel for variable declaration: One file

Type File name Detail
Excel for variable MCTest This is a list of NJ variables to be registered to the
declaration RunlAG_Variables.xlsx project using the IAG libraries.

11




3-3 Outline of System Configuration

12

Information between the IAGs and FBs are shared via the 3 mapping variables.
Information between the FBs and Servo are shared via the axis variables and SDO

communications.

NA

Axis status monitor IAG

T

Pop_Device_Info

HMI_Axis

Manual operation IAG

> HMI_Axis

Pop_Status_Data

Pop_Status_Data

Mapping variables A

T A
- }
—
W \ 4
HMI_IAG_Device_Info HMI_IAG_Axis HMI_IAG_Axis_Status
A A

| E—

Device Name Acquire FB

\ 4

HMI_IAG_Connect_
Devicelnfo

Manual Operation FB

HMI_IAG_Axis_Status

>»| HMI_IAG_Axis

<

Extract monitor h

axis information
only

, >
Axis_MonjitorNo|

HMI_IAG_ServoON_
Execute

A

_MC_AX
(Axis variables)

g

NJ-series

[ !

SDO communication
Acquire

Device name

Servo Drive (ECAT slave)

SDO communication: .
Acquire Start/stop axis Axis control
\__error information

~

A

U v

Error information

v




4 Use Cases

4-1 Axis Test Run Screen

You can perform a manual operation and the status monitoring of motion axes by combining
and placing “Axis status monitor IAG_(Full-screen)” and “Manual operation IAG” on the
page.

By placing all the objects for full-screen, you can also implement the Motion Axis Test Run
screen of the Sysmac Studio. In this case, place each “manual operation object” to the “tab
control object” so that all the IAGs are positioned on the same page.

RBBD-KNM L-ECT

® Homne
® hHome

Motion error

DnStatus

Command ca 3 E input

& nng input
Actual curres & NN INPL

Place “manual
operation
object” to

“tab control
object”.
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4-2 Axis Test Run Pop-up Page

You can create a pop-up page for operating and monitoring axes by placing the pop-up
objects on the pop-up page. As an example, a Jog feed screen is shown below.

None of IAG objects is corresponding to the
operation of pages. Therefore, when you place
[Close] button, position the IAG objects in the

@ Homed backmost position on the HMI proiect.
.Jr-.Hcm':

Sto

Top half: Axis status monitor IAG
Bottom half:Jog feed IAG

Dreceleration

O perafionsl only when the button is

aEE

The following is a screen when a pop-up page placed with the IAG objects is displayed on
top of the page for sensor thresholds. On this page, you can fine-tune the axes while
monitoring the sensor thresholds.

To enable a drag-and-drop operation, select the [Movable] checkbox in Properties on the
Pop-up page.

To operate the pop-up page and update its background screen, select [Modeless] for
[DisplayMode].

14



5 Details of IAG Specifications

5-1 Axis Status Monitor IAG

I 5-1-1 External Specification

Object name ServoStatus
Category IAG_MCTest_Popup
*1)
Function - Starts (enables)/ stops (disables) the specified axis.

- Switches the specified axis.

- Stops the operation of specified axis (emergency stop function).

- Displays the status of the specified axis.

*1) IAG category for popup page.
“IAG_MCTest_9inch” is the category for 9 inches, and “IlIAG_MCTest_12inch” is for 12 inches.

15



I5120u

® Pop-up page

NODE AXS

RBBD-KNO1 L-EC1 ~ 1 ©)

Commande Act

Pas 0 ®
0

Wel Vel

Status ® rionine W Homed
& Ready . opping = InHome
@ Cisbled 8 ctandsill @ ErcsSto

DrvStatus » Ready
B rsinPower @ Hemesw @ Latent
. Home . DrwvAlarm

® o7 ® mdstpy @ orvaming

® Full-screen

RE8D-KN L-ECT

. Homing
» hHome

U Motion error

Dn/Status - - ve limit input
Cammand current posit on
limit nput

Actual current tion - P nput

error mput

& ning input

oG © 0 O

No Name Description

1 [Servo ON/OFF] button | e Turns ON/ OFF the selected axis.

e Enabled when Servo is OFF, disabled when servo is ON.

2 Drop-down list e Shows the connected servo drives.

o Select the axis you want to monitor from the list.

3 Node and Axis No. » Shows the node No. and the axis No. of the selected axis.

4 Command value e Shows the command value.

5 Axis feedback value » Shows the axis feedback value.

6 Axis status * Monitors the status of the selected axis.

7 Error code o Shows the error code if there is an error during SDO' communication.
8 Servo status » Monitors the status of servo drive of the selected axis.




I 5-1-3 Properties

® Properties
Property name l Description Input method Range Default
General
Name Specifies the object name. The name must be Direct input String( 1 to 127 ServoStatus0
unique in that screen. characters)
Type Specifies the object type.This item cannot be - - IAG
changed.
Version Specifies the version of the IAG. - - 1.14A
Publisher Specifies the IAG publisher. - - Omron
Appearance
BackgroundColor Specifies the background color of the page. Item selection Color palette Transparent
Direct input String *1)
Layout
V¥ Position (Left, Top) Specifies the position of the object on the Direct input Numerical -
page.*2) Spin button Numerical *3)
Left Specifies the horizontal page coordinate (x-axis) | Direct input Numerical -
of the position of the top-left of the object. Spin button Numerical
Top Specifies the vertical page coordinate (y-axis) of | Direct input Numerical -
the position of the top-left of the object. Spin button Numerical
V¥ Size (Width,Height) Specifies the size of the object. Direct input Numerical For Pop-up:(231,268)
Spin button Numerical For 9 inches:(800,282)
For 12
inches:(1280,293)
*3)
Width Specifies the object width. Direct input Numerical For Pop-up:231
Spin button Numerical For 9 inches:800
For 12 inches: 1280
Height Specifies the object height. Direct input Numerical For Pop-up:268
Spin button Numerical For 9 inches:282
For 12 inches:293
Behavior (In/Out)
HMI_Axis Specifies the monitor axis information. Direct input Structures (Blank)
(_sAXIS_REF)
HMI_IAG_Axis_Status Specifies the value of operation parameter. Direct input Structures (Blank)
(IAG_Param_REF)
Pop_Device_lInfo Specifies the connected device information. Direct input Structures (Blank)

(IAG_Device_lInfo)

Properties screen

Position (Left, Top)
Left
Top
dth,Height)
th
Height
¥ Behavior (In/Out)
HMI_

Transparent

The properties of Pop-up IAG

*1)"Transparent” indicates that the colour is transparent.
*2)The coordinate origin is the upper-left corner of the NA-series PT screen.

*3)In units of pixels

17



® Event and action
There are no event and action functions.

©® Animation
You can define the basic animation action.
Animation name Description
Move Changes the coordinates of the object according to specified condition expressions.
Resize Height Changes the height of the object according to a specified condition expression.
Resize Width Changes the width of the object according to a specified condition expression.
Visibility Displays the object when a condition expression is met.

Animation screen

ServoStatus)

ResizeHaight
ResizeWidth

Visibility

® |/O variable timing

Variable Timing for loading input data Timing for outputting data
HMI_Axis - When executing the “List_ltemSet” subroutine. - When the [Servo ON/OFF] button is being pressed.
+ When changing a drop-down list item. + When [Deceleration stop] button is being pressed.
Pop_Status_Data - When executing the “List_ltemSet” subroutine. Constantly

+ When changing a drop-down list item.
- When there is an error.

Pop_Device_Info - When executing the “List_ItemSet” subroutine. Constantly
- When changing a drop-down list item.

I 5-1-4 Features

® Among the EtherCAT devices connected to the NJ, only servo drives are displayed in
the drop-down list and corresponded to the axis No.

® To display the connected servo drives, press the drop-down list.
*The servo drive with the smallest node No. is shown by default.

® Select any servo drive from the drop-down list, and then the status of the servo drive is
displayed in the display area.

® To turn ON/ OFF the selected servo drive, press the [Servo ON/OFF] button.

® To decelerate and stop the selected servo drive, press the [Deceleration stop] button
during the servo operation.

® |[f there is an error during manual operation, the error code is displayed in the display
area of servo status.

18



5-2 Jog Feed IAG

I 5-2-1 External Specification

Object name JogFeed

Category IAG_MCTest_Popup
1{1)

Function - Sets parameters for jog speed of the specified axis and others.
- Moves the specified axis in forward/reverse direction.

*1) IAG category for popup page.
“IAG_MCTest_9inch” is the category for 9 inches, and “IIAG_MCTest_12inch” is for 12 inches.

19
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® Pop-up page

Jog feed

Target speed

Acceleration

® Full-screen

®O O

@
©
@
No Name Description
1 [Apply] button ¢ Applies the target speed, acceleration, and deceleration that you entered
to the selected axis.
2 Target speed ¢ Sets the target speed.
o To directly enter set values, use the numeric keypad that will be displayed
by pressing in the numeral display area.
e To increment/decrement the set value, press the: [+] /[-] button.
3 Acceleration ¢ Sets the acceleration.
o To directly enter set values, use the numeric keypad that will be displayed
by pressing in the numeral display area.
e To increment/decrement the set value, press the: [+] /[-] button.
4 Deceleration o Sets the deceleration.
o To directly enter set values, use the numeric keypad that will be displayed
by pressing in the numeral display area.
e To increment/decrement the set value, press the: [+] /[-] button.
[Reverse operation] button | e The servomotor moves in the reverse direction according to the setting.
6 [Forward operation] button

e The servomotor moves in the forward direction according to the setting.




I 5-2-3 Properties

® Properties
Property name l Description Input method Range Default
General
Name Specifies the object name. The name must be Direct input String( 1 to 127 JogFeed0
unique in that screen. characters)
Type Specifies the object type.This item cannot be - - IAG
changed.
Version Specifies the version of the IAG. - - 1.14A
Publisher Specifies the IAG publisher. - - Omron
Appearance
BackgroundColor Specifies the background color of the page. Item selection Color palette Transparent
Direct input String *1)
Layout
V¥ Position (Left, Top) Specifies the position of the object on the page. Direct input Numerical -
*2) Spin button Numerical *3)
Left Specifies the horizontal page coordinate (x-axis) Direct input Numerical -
of the position of the top-left of the object. Spin button Numerical
Top Specifies the vertical page coordinate (y-axis) of Direct input Numerical -
the position of the top-left of the object. Spin button Numerical
V¥ Size (Width,Height) Specifies the size of the object. Direct input Numerical For Pop-up:(231,176)
Spin button Numerical For 9 inches:(800,176)
For 12
inches:(1280,293)
*3)
Width Specifies the object width. Direct input Numerical For Pop-up:231
Spin button Numerical For 9 inches:800
For 12 inches: 1280
Height Specifies the object height. Direct input Numerical For Pop-up:176
Spin button Numerical For 9 inches:176
For 12 inches:293
Behavior (In/Out)
HMI_Axis Specifies the monitor axis information. Direct input Structures (Blank)
(_sAXIS_REF)
HMI_IAG_Axis_Status Specifies the value of operation parameter. Direct input Structures (Blank)

(IAG_Param_REF)

Properties screen

¥ Appearance
BackgroundColor
¥ Layout
¥ Position (Left, Top)
Left
Top
Width,Height)
Width
Height
¥ Behavior (In/Out)
HMI_Axis

Poy .

The properties of Pop-up IAG

*1)"Transparent” indicates that the colour is transparent.

*2)The coordinate origin is the upper-left corner of the NA-series PT screen.

*3)In units of pixels
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® Event and action
There are no event and action functions.

® Animation
You can define the basic animation action.

Animation name Description

Move

Changes the coordinates of the object according to specified condition expressions.

Resize Height

Changes the height of the object according to a specified condition expression.

Resize Width

Changes the width of the object according to a specified condition expression.

Visibility

Displays the object when a condition expression is met.

Animation screen

Maove

ResizeHeight
ResizeWidth
Visibility

® |/O variable timing

Variable

Input timing Output timing

HMI_Axis

+ When [Forward operation] button is being pressed.
- When [Reverse operation] button is being pressed.

Pop_Status_Data

+ When [Apply] button is being pressed.

I 5-2-4 Features
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To directly enter set values, use the numeric keypad that will be displayed by pressing
in the numeral display area for each setting.

To increment/decrement the set value, press the [+] /[-] button in each setting.

The [Apply] button is enabled after changing the set value.

To apply the set value to the selected axis, press the [Apply] button.

The operation button of each direction is enabled by pressing the [Apply] button.
While the [Forward operation]/[Reverse operation] button is being pressed, the rotation
speed for servomotor will be accelerated at the set acceleration speed until it reaches
the target speed.

When the [Forward operation])/[Reverse operation] button is released, the rotation
speed for servomotor will be decelerated at the set deceleration speed until the
servomotor stops.



5-3 Absolute Positioning IAG

I 5-3-1 External Specification

Object name AbsolutePositioning

Category IAG_MCTest_Popup
1{1)

Function - Sets parameters for absolute positioning speed of the specified axis and others.
- Performs the absolute positioning of the specified axis.
- Stops the absolute positioning of the specified axis.

*1) IAG category for popup page.
“IAG_MCTest_9inch” is the category for 9 inches, and “IIAG_MCTest_12inch” is for 12 inches.
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® Pop-up page

fAbsolute positionng

Target position
Target speed
Aooeleration
Deceleration

Jerk
@

® Full-screen

SIGICI®RS)

No Name

Description

[N

[Apply] button

* Applies the target position, target speed, acceleration, deceleration, and

Jerk that you entered to the selected axis.

2 Target position

o Sets the target position.
e To directly enter set values, use the numeric keypad that will be displayed
by pressing in the numeral display area.

e To increment/decrement the set value, press the: [+] /[-] button.

3 Target speed

o Sets the target speed.
o To directly enter set values, use the numeric keypad that will be displayed
by pressing in the numeral display area.

e To increment/decrement the set value, press the: [+] /[-] button.

4 Acceleration

» Sets the acceleration.
e To directly enter set values, use the numeric keypad that will be displayed
by pressing in the numeral display area.

e To increment/decrement the set value, press the: [+] /[-] button.

5 Deceleration

o Sets the deceleration.
o To directly enter set values, use the numeric keypad that will be displayed
by pressing in the numeral display area.

e To increment/decrement the set value, press the: [+] /[-] button.

6 Jerk

¢ Sets the Jerk.
o To directly enter set values, use the numeric keypad that will be displayed
by pressing in the numeral display area.

e To increment/decrement the set value, press the: [+] /[-] button.

7 [Deceleration stop] button

¢ Decelerates and stops the servomotor.

[Operation] button

* Moves the servomotor to the target position according to the setting.




I 5-3-3 Properties

® Properties
Property name l Description Input method Range Default
General
Name Specifies the object name. The name must be Direct input String( 1 to 127 AbsolutePositioning0
unique in that screen. characters)
Type Specifies the object type. This item cannot be - - IAG
changed.
Version Specifies the version of the IAG. - - 1.14A
Publisher Specifies the IAG publisher. - - Omron
Appearance
BackgroundColor Specifies the background color of the page. Item selection Color palette Transparent
Direct input String *1)
Layout
V¥ Position (Left, Top) Specifies the position of the object on the page. Direct input Numerical -
*2) Spin button Numerical *3)
Left Specifies the horizontal page coordinate (x-axis) Direct input Numerical -
of the position of the top-left of the object. Spin button Numerical
Top Specifies the vertical page coordinate (y-axis) of Direct input Numerical -
the position of the top-left of the object. Spin button Numerical
V¥ Size (Width,Height) Specifies the size of the object. Direct input Numerical For Pop-up:(231,176)
Spin button Numerical For 9 inches:(800,176)
For 12
inches:(1280,293)
*3)
Width Specifies the object width. Direct input Numerical For Pop-up:231
Spin button Numerical For 9 inches:800
For 12 inches:1280
Height Specifies the object height. Direct input Numerical For Pop-up:176
Spin button Numerical For 9 inches:176
For 12 inches:293
Behavior (In/Out)
HMI_Axis Specifies the monitor axis information. Direct input Structures (Blank)
(_sAXIS_REF)
HMI_IAG_Axis_Status Specifies the value of operation parameter. Direct input Structures (Blank)

(IAG_Param_REF)

Properties screen

¥ General
Name
Type

Backgrour
¥ Layout
Position (Left, Top)
Left
Top
idth, Height)
h
Height
¥ Behavior (In/Out)
HMI_Axis

Pop_St 2

AbsolutePositioning0

Transparent -

The properties of Pop-up IAG

*1)"Transparent” indicates that the colour is transparent.

*2)The coordinate origin is the upper-left corner of the NA-series PT screen.

*3)In units of pixels
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® Event and action
There are no event and action functions.

® Animation

You

can define the basic animation action.

Animation name Description

Move

Changes the coordinates of the object according to specified condition expressions.

Resize Height

Changes the height of the object according to a specified condition expression.

Resize Width

Changes the width of the object according to a specified condition expression.

Visibility

Displays the object when a condition expression is met.

Animation screen

AbsolutePositioning0

Move
ResizeHeight
ResizeWidth
Visibility

® |/O variable timing

Variable

Input timing Output timing

HMI_Axis

+ When [Operation] button is being pressed.
- When [Deceleration stop] button is being pressed.

Pop_Status_Data

+ When [Apply] button is being pressed.

I 5-3-4 Features

26

To directly enter set values, use the numeric keypad that will be displayed by pressing
in the numeral display area for each setting.

To increment/decrement the set value, press the [+] /[-] button in each setting.

The [Apply] button is enabled after changing the set value.

To apply the set value to the selected axis, press the [Apply] button.

The [Operation] button is enabled after pressing the [Apply] button.

While the [Operation] button is being pressed, the servomotor keeps rotating until it
reaches the target position.

The servomotor accelerates at the acceleration speed until it reaches the target speed,
and decelerates at the deceleration speed to stop at the set target position.

* The servomotor may not reach the target speed depending on the set acceleration
speed and the target speed.

The acceleration/deceleration ratio varies depending on the Jerk setting.

To decelerate and stop the servomotor, pressing the [Deceleration stop] button.



5-4 Relative Positioning IAG

I 5-4-1 External Specification

Object name RelativePositioning

Category IAG_MCTest_Popup
1{1)

Function - Sets parameters for relative positioning speed of the specified axis and others.
- Performs the relative positioning of the specified axis.
- Stops the relative positioning of the specified axis.

*1) IAG category for popup page.
“IAG_MCTest_9inch” is the category for 9 inches, and “IIAG_MCTest_12inch” is for 12 inches.
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® Pop-up page

Relative positbning

® Full-screen

GISI®ISIS)

Name

Description

[Apply] button

¢ Applies the moving distance, target speed, acceleration, deceleration,

and Jerk that you entered to the selected axis.

Moving distance

¢ Sets the moving distance.
o To directly enter set values, use the numeric keypad that will be displayed
by pressing in the numeral display area.

e To increment/decrement the set value, press the: [+] /[-] button.

Target speed

¢ Sets the target speed.
o To directly enter set values, use the numeric keypad that will be displayed
by pressing in the numeral display area.

e To increment/decrement the set value, press the: [+] /[-] button.

Acceleration

o Sets the acceleration.
o To directly enter set values, use the numeric keypad that will be displayed
by pressing in the numeral display area.

e To increment/decrement the set value, press the: [+] /[-] button.

Deceleration

o Sets the deceleration.
¢ To directly enter set values, use the numeric keypad that will be displayed
by pressing in the numeral display area.

¢ To increment/decrement the set value, press the: [+] /[-] button.

Jerk

o Sets the Jerk.
¢ To directly enter set values, use the numeric keypad that will be displayed
by pressing in the numeral display area.

e To increment/decrement the set value, press the: [+] /[-] button.

[Deceleration stop] button

e Decelerates and stops the servomotor.

[Operation] button

e Operates the servomotor according to the setting.




I 5-4-3 Properties

® Properties
Property name I Description Input method Range Default
General
Name Specifies the object name. The name must be Direct input String( 1 to 127 RelativePositioning0
unique in that screen. characters)
Type Specifies the object type.This item cannot be - - IAG
changed.
Version Specifies the version of the IAG. - - 1.14A
Publisher Specifies the IAG publisher. - - Omron
Appearance
BackgroundColor Specifies the background color of the page. Item selection Color palette Transparent
Direct input String *1)
Layout
V¥ Position (Left, Top) Specifies the position of the object on the page. Direct input Numerical -
*2) Spin button Numerical *3)
Left Specifies the horizontal page coordinate (x-axis) Direct input Numerical -
of the position of the top-left of the object. Spin button Numerical
Top Specifies the vertical page coordinate (y-axis) of Direct input Numerical -
the position of the top-left of the object. Spin button Numerical
V¥ Size (Width,Height) Specifies the size of the object. Direct input Numerical For Pop-up:(231,176)
Spin button Numerical For 9 inches:(800,176)
For 12
inches:(1280,293)
*3)
Width Specifies the object width. Direct input Numerical For Pop-up:231
Spin button Numerical For 9 inches:800
For 12 inches:1280
Height Specifies the object height. Direct input Numerical For Pop-up:176
Spin button Numerical For 9 inches:176
For 12 inches:293
Behavior (In/Out)
HMI_Axis Specifies the monitor axis information. Direct input Structures (Blank)
(_sAXIS_REF)
HMI_IAG_Axis_Status Specifies the value of operation parameter. Direct input Structures (Blank)

(IAG_Param_REF)

Properties screen

¥ General

Name RelativePositioning0

Type

Version

Publisher
¥ Appearance

Width, Height)
Width

¥ Behavior (In/Out)

Transparent -

The properties of Pop-up IAG

*1)"Transparent” indicates that the colour is transparent.

*2)The coordinate origin is the upper-left corner of the NA-series PT screen.

*3)In units of pixels

29



® Event and action
There are no event and action functions.

® Animation

You can define the basic animation action.

Animation name Description

Move

Changes the coordinates of the object according to specified condition expressions.

Resize Height

Changes the height of the object according to a specified condition expression.

Resize Width

Changes the width of the object according to a specified condition expression.

Visibility

Displays the object when a condition expression is met.

Animation screen

Move

ResizeHeight
ResizeWidth
Visibility

® |/O variable timing

Variable

Input timing Output timing

HMI_Axis

- When [Operation] button is being pressed.
+ When [Deceleration stop] button is being pressed.

Pop_Status_Data

- When [Apply] button is being pressed.

I 5-4-4 Features
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To directly enter set values, use the numeric keypad that will be displayed by pressing
in the numeral display area for each setting.

To increment/decrement the set value, press the [+] /[-] button in each setting.

The [Apply] button is enabled after changing the set value.

To apply the set value to the selected axis, press the [Apply] button.

The [Operation] button is enabled after pressing the [Apply] button.

While the [Operation] button is being pressed, the servomotor keeps rotating by the set
moving distance.

The servomotor accelerates at the acceleration speed until it reaches the target speed,
and decelerates at the deceleration speed to stop at the set moving distance.

* The servomotor may not reach the target speed depending on the set acceleration
speed and the target speed.

The acceleration/deceleration ratio varies depending on the Jerk setting.

To decelerate and stop the servomotor, press the [Deceleration stop] button.



5-5 Homing IAG

I 5-5-1 External Specification

Object name Homing

Category IAG_MCTest_Popup
1{1)

Function - Performs homing of the specified axis.
- Stops homing of the specified axis.

*1) IAG category for popup page.
“IAG_MCTest_9inch” is the category for 9 inches, and “IIAG_MCTest_12inch” is for 12 inches.
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® Pop-up page

Homing is performed &

in “Hao

coording
he Homing g

g setting

No Name Description
1 [Deceleration stop] button o Decelerates and stops the servomotor.
2 [Operation] button e Returns the servomotor to its home position.




I 5-5-3 Properties

® Properties
Property name l Description Input method Range Default
General
Name Specifies the object name. The name must be Direct input String( 1 to 127 Homing0
unique in that screen. characters)
Type Specifies the object type.This item cannot be - - IAG
changed.
Version Specifies the version of the IAG. - - 1.14A
Publisher Specifies the IAG publisher. - - Omron
Appearance
BackgroundColor Specifies the background color of the page. Item selection Color palette Transparent
Direct input String *1)
Layout
V¥ Position (Left, Top) Specifies the position of the object on the page. Direct input Numerical -
*2) Spin button Numerical *3)
Left Specifies the horizontal page coordinate (x-axis) Direct input Numerical -
of the position of the top-left of the object. Spin button Numerical
Top Specifies the vertical page coordinate (y-axis) of Direct input Numerical -
the position of the top-left of the object. Spin button Numerical
V¥ Size (Width,Height) Specifies the size of the object. Direct input Numerical For Pop-up:(231,176)
Spin button Numerical For 9 inches:(800,176)
For 12
inches:(1280,293)
*3)
Width Specifies the object width. Direct input Numerical For Pop-up:231
Spin button Numerical For 9 inches:800
For 12 inches: 1280
Height Specifies the object height. Direct input Numerical For Pop-up:176
Spin button Numerical For 9 inches:176
For 12 inches:293
Behavior (In/Out)
HMI_Axis Specifies the monitor axis information. Direct input Structures (Blank)
(_sAXIS_REF)
HMI_IAG_Axis_Status Specifies the value of operation parameter. Direct input Structures (Blank)

(IAG_Param_REF)

Properties screen

BadkgroundColor
¥ Layout

¥ Position (Left, Top)

width
Height
¥ Behavior (In/Out)

Data

The properties of Pop-up IAG

*1)"Transparent” indicates that the colour is transparent.

*2)The coordinate origin is the upper-left corner of the NA-series PT screen.

*3)In units of pixels
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® Event and action
There are no event and action functions.

® Animation
You can define the basic animation action.

Animation name Description

Move

Changes the coordinates of the object according to specified condition expressions.

Resize Height

Changes the height of the object according to a specified condition expression.

Resize Width

Changes the width of the object according to a specified condition expression.

Visibility

Displays the object when a condition expression is met.

Animation screen

Move
ResizeHeight
ResizeWidth

Visibility

® |/O variable timing

Variable Input timing Output timing

HMI_Axis

+ When [Operation] button is being pressed.
- When [Deceleration stop] button is being pressed.

Pop_Status_Data

I 5-5-4 Features
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® To return the servomotor to its home position, press the [Operation] button.
® To decelerate and stop the servomotor, press the [Deceleration stop] button.
® You can view the status of homing in the display area of axis status monitor IAG.



© Details of FB Specifications

6-1 Axis Information Acquire FB

I 6-1-1 External Specification

Instruction Name IfUBl{l Graphic expression ST expressions
HMI_IAG_Init_FB Acquiring FB HMI_IAG_Init_instance HMI_IAG_Init_instance(
axis ML IAG_Intt_FB Execute: = (parameter),
information Done=> {parameter),
= Execute Done  jumm
Busy=> (parameter),
Busy fem | Eror=> (parameter),
Error = | ErroriD=> (parameter),
ErrorlD mm | ErrorlD_Ex=> {parameter)
ErrorlD_Ex s );
I 6-1-2 Input Variable
. Valid e
Input variable Name Data type Default Description
range
Execute Start BOOL TRUE, FALSE The instruction is executed when Execute changes to TRUE.
FALSE
I 6-1-3 Output Variable
Input variable Name Data type Valid Description
range
Done Done TRUE, . Lo
BOOL FALSE TRUE when the instruction is completed.
Busy During execution BOOL TRUE, TRUE when the instruction is acknowledged.
FALSE
Error Error TRUE, . .
BOOL FALSE TRUE while there is an error.
ErrorlD Error code WORD * Outputs the error code when an error occurs.
Outputs 16#0000 under normal operation.
ErrorlD_Ex Expansion error DWORD * Outputs the expansion error code when an error occurs.
code Outputs 16#0000 under normal operation.
® Output variable update timing
Variable Timing for changing to TRUE Timing for changing to FALSE
Done When the instruction is completed. One period after Busy changes to FALSE.
Busy When Execute changes to TRUE. Done changes to TRUE.
Error changes to TRUE.
Error When there is an error in the execution conditions or | When the error is cleared.

input parameters for the instruction.
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I 6-1-4 External Variable

External Variable Name Data Valid Description
type range
HMI_IAG_Connec | Specifies the IAG_D *
t_Devicelnfo connected device evice_| Information of the devices connected to PLC with EtherCAT communications.
information. nfo *1
_EC_NetCfgErr *2 | Network TRUE,
configuration BOOL FALSE TRUE if there is illegal network configuration information.
information error
_EC_MBXSlavTbl Message ARRAY TRUE, A list of slaves that can perform message communications. Slaves are given
*2 communications [1..192] FALSE in the table in the order of slave node addresses. The element for a slave is
enabled slave table OF TRUE if message communications are enabled for it (pre-operational,
BOOL safe-operation, or operational state).
_MC_AX*3 Axis variables ARRAY *
[0..63] Axis Variables are system-defined variables for some of the axis parameters
OF and for the monitor information, such as the actual position and error
_SAXis_ information for the axes controlled by the MC Function Module.
REF

*1 For details on data type of [IAG_Device_Info], refer to section 7 of this guide.

*2 For details on variable of [ EC_NetCfgErr] and [ EC_MBXSIavTbl], refer to NJ/NX-series CPU Unit
Built-in EtherCAT® Port User’s Manual (Cat. No. W505).

*3 For details on variable of [ MC_AX], refer to NJ/NX-series CPU Unit Motion Control User's Manual (Cat.
No. W507).

I 6-1-5 Features

® Extracts the node number of the devices connected to the NJ via the EtherCAT
communications.

® Associates the axis number with the node number.

® Extracts the device name of the devices connected to the NJ via the EtherCAT
communications.
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©6-2 Manual Operation FB

I 6-2-1 External Specification

FB
Instruction Name FUlil Graphic expression ST expressions
HMI_IAG_Axis_FB Manual FB HMI_IAG_Axis_instance HMI_IAG_Axis_instance(
operation "Ml 1AG 2ods FB Execute: = {parameter),
-7 Home_TriggerVariable: = {parameter),
= Execute Busy jmm
) ) Busy=> (parameter),
mm Home_TriggerVariable Axis_MonitorNo: = {parameter)
m AXis_MonitorNo Axis_MonitorNO  jumm

)

I 6-2-2 Input Variable

Input variable Name Data type Valid Default Description
range
Execute Start BOOL TRUE, FALSE The instruction is executed when Execute changes to TRUE.
FALSE
Home_TriggerVari | Home S|lgnal for BOOL TRUE, FALSE Specifies the home input signal for homing.
able external input FALSE
I 6-2-3 Output Variable
Vali
Input variable Name Data type alid Description
range
Busy During execution BOOL TRUE, TRUE when the instruction is acknowledged.
FALSE
® Output variable update timing
Variable Timing for changing to TRUE Timing for changing to FALSE
Busy When executing the stop processing When terminating the stop processing

When performing the absolute positioning
When performing the relative positioning
When performing the homing

When terminating the absolute positioning
When terminating the relative positioning
When terminating the homing

I 6-2-4 1/0O Variable

Vali
Input variable Name Data type alid Description
range
Axis_MonitorNo Monitor axis No. No. of axis that is being monitored.
UINT Connects with HMI_IAG_Connect_Devicelnfo.Axis_MonitorNo. of Axis

Information Acquire FB.
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I 6-2-5 External Variable

External Variable Name Data Valid Description
type range
_MC_AX*1 Axis variables ARRAY *
[0..63] System-defined variables for some of the axis parameters and for the monitor
OF information, such as the actual position and error information for the axes
_SAXxis_ controlled by the MC Function Module.
REF
HMI_IAG_Axis Monitor axis _SAxis_ * Some of the axes which is being monitored with IAG, and the monitor
information. REF information, such as the actual position and error information.
HMI_IAG_Axis_St | Jog feed status IAG_Pa *
atus ram_R The set value and error code of each operation for MC Test Run.
EF *2
_EC_PDSlavTbl Process data ARRAY TRUE A list of slaves that are performing process data communications. Slaves are
*3 communicating [1..192] FALSE given in the table in the order of slave node addresses.The element for a
slave table OF slave is TRUE if process data of the corresponding slave is enabled
BOOL (operational) for both slave inputs and outputs.
*_EC_CommErrTbI Communications ARRAY TRUE Slaves are given in the table in the order of slave node addresses. The
3 error slave table [1..192] FALSE ; . .
OF corresponding slave element is TRUE if the master detected an error for the
BOOL slave.
HMI_IAG_ServoO IAG selected axis ARRAY TRUE
N_Execute start [0(')'?:3] FALSE Execute Flag of axis selected with IAG. TRUE when axis is executed.
BOOL
*1 For details on variable of [ MC_AX], refer to NJ/NX-series CPU Unit Motion Control User’s Manual (Cat.

No. W507).

*2 For details on data type of [IAG_Param_REF], refer to section 7 of this guide.

*3 For details on variable of [ EC_PDSIlavTbl], [ EC_CommErrTbl], refer to NJ/NX-series CPU Unit Motion
Control User’'s Manual (Cat. No. W507).

I 6-2-6 Features

® Performs the jog feeding.

® Performs the absolute positioning.
® Performs the relative positioning.
® Performs the homing.

® Performs the deceleration stop.
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/ Details of Variable Specifications

/-1 Structures Registered in FB Library of NJ

I 7-1-1 Axis Information Acquire FB

Variable name Data type Name Function
IAG_Device_Info STRUCT Structures for connected device information.
Axis_MonitorNo UINT Monitor axis No. An axis number of the device to be monitored.
Connect_NodeNo ARRAYI0..199] Connected node No. A node number of the connected device.
OF STRING[10]

Device_Name

ARRAY[0..199]
OF STRING[50]

Connected device name

A name of the connected device.

Device_Count

UINT

Number of connected devices

The number of the connected devices.

Axis_Tbl_AxisNo

ARRAYI0..255] OF UINT

Information of connected axis
No.

A variable for retaining the valid axis number.

Axis_Tbl_NodeNo

ARRAYI0..255] OF UINT

Information of node No. in order

A variable for retaining the valid node number.
of connected axis

Select_NodeNo ARRAYI0..199]

OF STRING[50]

Servo-recognized node No. A node number of the connected servo.

First_Chk BOOL Flag for checking the

after-startup connection status

Flag for checking the connection status.

I 7-1-2 Manual Operation FB

Variable name Data type Name Function
IAG_Param_REF STRUCT Structures for status of jog feed.

Velocity LREAL Target speed The target speed during the operation of servomotor.
Acceleration LREAL Acceleration The acceleration during the operation of servomotor.
Deceleration LREAL Deceleration The deceleration during the operation of servomotor.
Jerk LREAL Jerk The jerk during the operation and deceleration stop of servomotor.
Position LREAL Target position The target position for decelerating and stopping the servomotor.
Distance LREAL Moving distance The distance for moving the servomotor.
Execute BOOL Operation start request An operation start request for the servomotor.
Posi_Nega BOOL Ezgl(:;at:io;oiiirﬁlgrtlif;n(: Nega) The direction of rotating the servomotor.
ServoStop BOOL Servo stop request A stop request for the servomotor.
ServoOn BOOL Servo ON request A request for turning ON the servomotor.

Function flag( A selection flag for MC Test Run function to be executed.
Function_Flg UINT 1=Jog ,2=Absolute ,

2=Relative ,4=Homing , )
Stop_Error BOOL Stop error An error flag when executing the stop processing.
Abs_Error BOOL Absolute positioning error An error flag when performing the absolute positioning.
Rel_Error BOOL Relative positioning error An error flag when performing the relative positioning.
Home1_Error BOOL Home position 1 error An error flag when homing with external signal.
Home2_Error BOOL Home position 2 error An error flag when homing.
Stop_ErrorID WORD Stop error code An error code when executing the stop processing.
Abs_ErrorlD WORD ?g;g'lﬂe positioning error An error code when performing the absolute positioning.
Rel_ErrorlD WORD (I?:(;Ztive positioning error An error code when performing the relative positioning.
Home1_ErrorID WORD Homing 1 error code An error code when homing with external signal.
Home2_ErrorlD WORD Homing 2 error code An error code when homing.
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/-2 Structures Registered in IAG Object of NA

The same structures as that of FB for NJ are registered.
(The data types conform to NA)

Variable name Data type Name Function
IAG_Device_Info STRUCT Structures for connected device information.
Axis_MonitorNo UShort Monitor axis No. An axis number of the device to be monitored.
Connect_NodeNo String(199) Connected node No. A node number of the connected device.
Device_Name String(199) Connected device name A name of the connected device.
Device_Count UShort Number of connected The number of the connected devices.
devices
Axis_Tbl_AxisNo UShort(255) Information of connected A variable for storing the valid axis number.
axis No.
Axis_Tbl_NodeNo UShort(255) Information of node No. in A variable for storing the valid node number.
order of connected axis
Select_NodeNo String(199) Servo-recognized node No. A node number of the connected servo.
First_Chk Boolean Flag for checking the A Flag for checking the after-startup connection status.
after-startup connection
status
Variable name Data type Name Function
IAG_Param_REF STRUCT Structures for status of jog feed.
Velocity Double Target speed The target speed during the operation of servomotor.
Acceleration Double Acceleration The acceleration during the operation of servomotor.
Deceleration Double Deceleration The deceleration during the operation of servomotor.
Jerk Double Jerk The jerk during the operation and deceleration stop of
servomotor.
Position Double Target position ZZ;;?T:%?;:_)OSNO” for decelerating and stopping the
Distance Double Moving distance The distance for moving the servomotor.
Execute Boolean Operation start request An operation start request for the servomotor.
Operation direction( The direction of rotating the servomotor.
Posi_Nega Boolean False = Posi /
True = Nega)
ServoStop Boolean Servo stop request A stop request for the servomotor.
ServoOn Boolean Servo ON request A request for turning ON the servomotor.
|1:Uf10ﬁ0n flag( A selection flag for MC Test Run function to be executed.
Function_Flg UShort Z;i%%olﬁte ,
2=Relative ,
4=Homing, )
Stop_Error Boolean Stop error An error flag when executing the stop processing.
Abs_Error Boolean Absolute positioning error An error flag when performing the absolute positioning.
Rel_Error Boolean Relative positioning error An error flag when performing the relative positioning.
Home1_Error Boolean Home position 1 error An error flag when homing with external signal.
Home2_Error Boolean Home position 2 error An error flag when homing.
Stop_ErrorlD UShort Stop error code An error code when executing the stop processing.
Abs_ErroriD UShort égsg'ute positioning error An error code when performing the absolute positioning.
Rel_ErrorlD UShort 5:(|jaeﬁve positioning error An error code when performing the relative positioning.
Home1_ErrorID UShort Homing 1 error code An error code when homing with external signal.
Home2_ErrorlD UShort Homing 2 error code An error code when homing.
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8 Install Procedure

You can use the IAG files and FB library files by importing them and making simple settings.

NJ settings

Registering NJ Variables |

v

‘ Importing FB Library File |

v

‘ Adding FB to NJ Program |

v

‘ Adding Axis Start Variables |

NA settings
‘ Registering and Mapping NA Variables |

v

‘ Importing IAG File |

v

‘ Placing IAG Object on NA Screen |

v

‘ Adding Program to NA Screen |

The detailed procedures are listed on the following pages.

m Precautions for Correct Use

This guide assumes that parameters and axes for each servo drive have been set
properly. Check these settings thoroughly before installation.
For how to set the servo drives, refer to each relevant manual.
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8-1 Registering NJ Variables

I 8-1-1 I/ F Variables for IAG and FB

I/ F variables of IAG and FB for MC Test Run are defined in the FB external variable as data
type variable (structures). To allow the NA to access to the FB external variables, register
the FB external variable in the global variable table of NJ.

The following table shows the NJ variables to register

Name Data type Comment

HMI_IAG_Axis sAXIS_REF Monitor axis information for IAG

HMI IAG_Axis Status IAG_Param_ REF Jog feed status for IAG
HMI_IAG_Connect_Devicelnfo IAG_Device_Info Connected device information for IAG
HMI_IAG_SeavoON_Execute ARRAY[0..63] OF BOOL | Axis start processing for IAG

The data types of these variables are defined in FB, so you don’t need to define them in
[Data type] of the NJ Editor.
To access to these variables from NA, register the variable name to the global variable.

I 8-1-2 Variable Registration Procedure

Register the NJ variables before importing the FB library file.

Eﬂ Additional Information

A validation error will occur at this moment because the data types to be used for
variables are not valid until the FB library file has been imported.

For example, a validation error for “lIAG_Device_Info” will be cleared after importing
the "Axis Information Acquire FB”, and a validation error for “lIAG_Param_REF” will be
cleared after importing the “Manual Operation FB”.

The registration procedure of the NJ variables is listed on the following pages.
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1. Select "Programming” ->’Data”
->"Global Variables” from the
multiview explorer of NJ project
and double-click (or right-click ->
Edit) to open the "Global Variable”
table.

2. While the “Global Variables” table
is active, right-click->"Create
New” and register the NJ
variables given in the table earlier
in this section.

3. A validation error will occur but
will be cleared after importing the

FB library file in the next step. ==

ARRAYI0.63] OF BOOL

=
Additional Information

Using the excel file for variable declaration allows you to copy and paste variables.
In step 2 above, copy the following data and paste them by sellecting “Paste”.

Al - MS PT-11 - A A EF- % v
A BIED-A-EH-28F

1 |HMIIAG Axis SMAISREr

2 [HMIIAG_ Axis Status 3 tnEnm

3_[HMLIAG Connect Devieslnf * °%°)

4 |HMIIAG SeawoON Execute -3 E—(C)

5 B MORHOATSaY:

6 5

7 "

8 iz

9 182

10 -

11

12 B

D

E

F

G H

FALSE
FALSE
FALSE
FALSE

FALSE
FALSE
FALSE
FALSE

Do not put Monitor axis information for IAG

Do not put Jog feed status for IAG

Do not putConnected device information for [AG
Do not put Axis start processing for IAG
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8-2 Importing FB Library File

-How to import the FB library files

1. Select “Project” ->"Library” [ New Project - new_Controlier 0 = ysmac SO e —
->"Show References” from the I .
menu of NJ project. v & a

Multiview Explorer

Check All Programs
Check Selected Programs Shift+F7

Co ller 0
e Abort Build Shift+F3

Memory Usage
Online Edit

2. The Library Reference window
opens. Click the [Edll button.

B Indude the referenced libraries

3. The dialog on the right opens. e e e =
. . . e b « LocalDisk(C:) » OMRON » Data » Lib » - | by earch Lib =]
Sele_ct a FB library file to import. T — e

In this example, select wr—

BC_DeviceManitor

“IAGCont_DeviceWindow_MCTe e
st Run_V1_0.slr". 5 Documents

o' Music

i/ Pictures
B videos = L J
& Rotary¥indfe_verl 1 3

% Computer

i Netwaork

File narme: IAGCont_DeviceWindow MCTestRun V10 = ’Wmhb’!!}f‘kl'—m )
Open | [ Cancel

4. The FB library file has been
imported.
Use the same procedure and
import
“IAGCont_DeviceWindow_Read
DeviceName_V1_0.slr”.
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8-3 Adding FB to NJ Program

Place the specified FB to the NJ program and write the required programs.

‘How to add FB to "Section0” ( created by default when NJ project was created) with ladder.

1. Select “Programming” ->“POUS”
->"ProgramQ” ->"Section0” from
the menu of NJ project.

* A validation error will occur but will
be cleared after writing the ladder.

2. Select IAGCont_DeviceWindow
MCTest Run_V1_0” from

Toolbox. IAGCont_DeviceWindow _I
TAGCont_DeviceWindow_}|
Analog Conversion
BCD Conversion
Bit String Processing

Communications

3. Drag "HMI_IAG_Axis_FB’ from
the drop-down list to the ladder
editor.

|
¥ [AGCont_DeviceWindow_{

» IAGCont_DeviceWindow_|

» Analog Conversion
» BCD Conversion
P Bit String Processing

» Communications

» Comparison

» Conversion

4. The FB has been added.

5. Write the programs as shown on
the right.

HMI_IAG_Awis_FB Ins
HMI_IAG_Axis_F8

9

Busy|

Home_TrigperVarianie— Home_TriggerVasiable

In this example, instance egre et el a IR
“H M I_IAG_AXiS_FB” iS named aS Connected devic Connected device info
“‘HMI_IAG_Axis_FB_Ins”.




In addition, set the home input
signal of the environmental
condition you used to
“Home_TriggerVariable”.

When using the ST structure, the
above ladder diagram is written as
shown on the right. Execute : = P_ON,

HMI_IAG_Axis_FB_Ins (

Home_TriggerVariable : = Home_TriggerVariable,

Axis_MonitorNo : = HMI_IAG_Connect_Devicelnfo.Axis_MonitorNo

Select "HMI_IAG_Init_FB” from . Tt R
“IAGCont_DeviceWindow_Read I} Execste.  Done
DeviceName_V1_0.slr” and write iy |
the program as shown on the '
right. i
ErroriD|—Enter
In this example, instance EodD Exl
“HMI_IAG_Init_FB” is named as i

“HMI_IAG_Init_FB_Ins’.

When using the ST structure, the
above ladder diagram is written as
shown on the right. Execute : = P_ON

HMI_IAG_Init_FB_Ins(




8-4 Adding Axis Start Variables

I 8-4-1 Axis Start Variables and “MC_Power” Instruction

To start axes from the NA (IAG), add an input condition of the axis start variables for this
IAG to the input of “MC_Power” instruction.

Since more than one “MC_Power” instruction cannot be placed to an axis, add the OR
circuit of “HMI_IAG_SeavoON_Execute[*]”, which is a start trigger from this IAG, to the input
circuit of “MC_Power” instruction located in the entire control program.

Since the “MC_Power” instruction exists for each axis, combine
“HMI_IAG_SeavoON_Execute[X]” with “MC_Power” instruction for X-axis to add.

Axis 1
Axis 2
MC_Power
Axis 3
Input circuit used
by the entire ()
control program N )

Axis start variables

I F
Add

I \ J
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I 8-4-2 Design Procedure of Axis Start Circuit

-How to design the axis start circuits when using this IAG

1. Double-click (or right-click -> Edit)
the program that uses the
MC_Power instruction from the
multiview explorer of NJ project to
open the ladder editor.

(In this example, "Programming”
->"POUs” ->"Common”
->"Common”)

2. Make sure that each axis has
been started using “MC_Power”
instruction.

(In this example, lines 7 and 8)

3. Drag the area from the left end of
the line to the area you want to B e

make connection. Sl R
i o s
Ty re‘m’.l\_%w_ tupyl-
4. A prompt asking you for the object esuz) 7
type to add is displayed. '
Select "N.O. Input (C)”. i NS 1 Servo0n

NS_I_Axis2_SenvoOn
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After adding the contact, set the
added "HMI_IAG_ServoON_Exec
ute” NJ variable there.

For axis 0, set
“HMI_IAG_ServoON_Execute[0]".
For axis 1, set
“‘HMI_IAG_ServoON_Execute[1]".
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8-5 Registering and Mapping NA Variables

I 8-5-1 Mapping I/F Variable to NA

Add the data type variable used for IAG to the global variable list of NA.
Use the usual variable mapping procedure for this registration.

The following table shows the NJ variables to map to the NA.

Name Data type Update rate Comment
HMI_IAG_Axis _sAXIS_REF 100 ms -
HMI_IAG_Axis_Status IAG_Param_REF 100 ms -
HMI_IAG_Connect Devicelnfo IAG_Device Info 500 ms -

I 8-5-2 Variable Mapping Procedure

Since the NJ variables have been registered to the NJ global variable in Step 8-1, use the
usual procedure for mapping.

-How to map the NA variables

1. Select "Configurations and Setup”
->"Variable Mapping” from the
multiview explorer of NA project
and double-click (or right-click ->
Edit) to open the "Variable
Mapping” table.

2. Select the user variables for the
Controller in the “Variable
Mapping” table to display the NJ
global variables.

3. Enter the NA variable names in
the “Variable” column.
(In this example, the NJ variable
names are used for the NA
variable names)
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4. Select "HMI” ->"Data” ->"Global
Variables” from the multiview
explorer and double-click (or
right-click -> Edit) to open
the "Global Variables” table.

5. Make sure that the NA variables
are set as you entered in step 3.
Set the update rates given in the
table earlier in this section.
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8-6 Importing IAG File

-How to import the IAG file to the HMI project

B e e A S P - — ————

1. Select "Project” ->"IAG Collection
Manager” from the menu of NA
project.

2. The IAG Collection Manager
window is displayed.
Click the button.

3. The dialog on the right opens. ?;Z‘ — =
Select "DeviceWindowlAG_114A —— ' ey
_E_MCTest Run_Popup.iag”. T— - ;

I DeviceWindowlAG_ 1144 E WCTemRun_ . 110016130 P 1AG Fle I
i Libraries

¥ Decuments
o Music
= Poctures
B videos

1% Computer

i Metwork

File nasme DevsceWindowbhG_1144_E MCTestRun Pop = |IAG Collectis Fies [ag)

4. The IAG has been imported.
Select the “Show in Toolbox”
checkbox on the top right corner
and close the dialog.

(The IAG object can be enabled
on the HMI page by selecting this
checkbox).
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8-7 Placing IAG Object on NA Screen

-How to use the imported IAG objects on the HMI screen

1. Select ’"HMI” ->"Pages” from the
multiview explorer of NA project
and select the page, in which you
want to place the IAG, and
double-click(or right-click -> Edit)
to open the page editor.

2. Select”IAG_MCTest_Popup” that
was added in Toolbox.

3. The five IAG objects are
expanded. Place them to the
page editor in the same way as
you place usual objects.

4. The IAG object has been placed.
(In this example,ServoStatus is
placed)

o [ Eralet (United States) v
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5. To use the IAG objects, set I/0
variable in Properties of IAG
objects.

Register each variable in
Behaviour (In/Out) of Properties
by following “3-2 Outline of
System Configuration”.

o [EE Eroteh (United States) +
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8-8 Adding Subroutine/ Event and Action to Page

You need to write the subroutines and Event and Action on the NA page in the following

cases.

IAG Required/ Not required Extra work

Axis status monitor IAG Required Event and Action
Subroutine

Manual operation IAG

Required when one manual operation IAG | Event and Action

is positioned on the page.

Manual operation IAG

Required when multiple manual operation | Event and Action
IAGs are positioned on the same page Subroutine

such as tab control object.

The details and sample program are described in the following section.

I 8-8-1 Extra Work for Using Axis Status Monitor IAG

Axis status monitor IAG objects can acquire the name of the connected servos and
displayed them in a drop-down list.
You need to define the execution timing of this function in Event and Action and call the

subroutine inside IAG. Normally, this function is executed when the corresponding page is

displayed.

-How to make the setting

1. Select “Pages” -> “Popup” from

the multiview explorer of NA

project and select the page, on

which you placed IAG, and

right-click->select "View Code
Editor” to display the code editor

of page subroutine.

¥ [ Pages

L BB StartupPage

iew Page Editor

Code Edito

Delete
Cut
Copy

Move Down

on the right to the page
subroutine.

(In this example, the object name

of axis status monitor IAG
is "ServoStatus0”)

Write the sample program shown

é-Su

BP0 sl O R

b Call_IAG_Sub

ServoStatusO.List_ItemSet

End Sub
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3.

Select “Pages” -> “Popup” from
the multiview explorer of NA
project and select the page, on
which you placed IAG, and
right-click->select "Page Editor” to
display the page editor.

4. Select Event and Action” from
Toolbar.
5. Select "PageDisplayed” for Events and Actions
Events and "CallSubrutine” for PO000_Axis_Jog2
Actions. ¥ Events < Select Event to Adc ~
Enter "Call_IAG_Sub” that you v [0] PageDisplayed @

set in step 2 for Subroutine. v Ao <« Select Action to.Adh =

v [0] CallSubroutine ]
LG Call_IAG_Sub
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inside the IAG.



I 8-8-2 Extra Work for Using Single Manual Operation IAG on Page

The manual operation FB that corresponds to the manual operation IAG is monitoring the
function selection flag held by the manual operation IAG, and switches the MC Test Run
function to be executed.

The following table shows the correspondence between the manual operation IAG and the
function selection flags.

Manual operation IAG

Function selection flag

Jog Feed IAG

HMI_IAG_Axis_Status.Function_FIlg =0

Absolute Positioning IAG

HMI_IAG_Axis_Status.Function_Flg =1

Relative Positioning IAG

HMI_IAG_Axis_Status.Function_Flg = 2

Homing IAG

HMI_IAG_Axis_Status.Function_Flg = 3

To execute the function that corresponds to the manual operation IAG displayed on the NA,
select the function selection flag in Events when the page, on which the manual operation
IAG is placed, is displayed (PageDisplayed).

-How to make the setting.

1. Select “Pages” -> “Popup” from
the multiview explorer of NA
project and select the page, on
which you placed IAG, and
right-click->select "Page Editor” to
display the page editor.

2. Select "Event and Action” from
Toolbar.

3. Select "PageDisplayed” for
Events and select ” SetVariable”
for Actions.

Enter "THMI_IAG_AXxis_Status.Fun
ction_Flg” for Variable and enter

the number Correspondlng to the Variable HMI_IAG_Axis_Status.Function_Flg
displayed IAG for Value. Value 0

PageDisplayed

< Select Action to Add >

CallSubroutine({"Call_IAG_Sub”™) @&

Setvariable i

After performing the above procedure, you can run the manual operation IAG.

=
Additional Information

You don’t need to perform the above procedure when multiple manual IAGs are
placed on the same page.
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I 8-8-3 Extra Work for Using Multiple Manual Operation IAGs on Page with Tab Control

Placing multiple manual operation IAGs such as tab control objects on the same page
results in unexpected operations due to the conflict occurred in the function selection flag.

To avoid this, set the function selection flag for “Variable” in Properties of tab control object
so that the multiple manual operation IAGs can be successfully operated on the same page.

 The setting procedure is given below

® \When placing IAG on tab page in the order of function selection flag

Select “Pages” -> “Popup” on
which you placed IAG and
double-click (or right-click->"the
page editor”) from the multiview
explorer of NA project to display
the page editor.

Select the tab control object you
want to palce IAG and display
properties from Toolbar.

Set "HMI_IAG_Axis_Status.Funct
ion_Flg” for the “Variable” in
Properties.

Top

20

Segoe UL, 12, Normal
Canter

Center

4

| ESS

White

White

HMI_IAG_Axis_Status.Function_Flg

2 +

58



Place the IAG on each tab page
so that the index of tab page
corresponds to the function
selection flag.

(Example: TabPage0O = JogFeed
IAG)

¥ [0]

Name

» Text (Default)

Cd

HMI_IAG_Axis_Status.Function_Flg

4 +

JogFeed a
TabPage0

| B

Nona

MNone

AbsolutePositioning

TabPagel

TabPage

AbsolutePositioning

130

ot
Additional Information

You don’t need to perform the above procedure when single IAG is placed on the

Same page.
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® \When placing any IAG manual operation on any tab page

By calling up the subroutine that switches the function selection flags from
“SelectionChanged” event of the tab control object, you can place any manual operation
IAG and operate it properly on any tab page.

To display the tab page correctly when changing the corresponding page for the first time or
after switching the function selection flag by the Controller, you also need to call up the
same subroutine in the "PageDisplayed” event,.

*How to place the “absolute positioning IAG” and “homing IAG” only on the tab page.

S —
i i v st st v iy,
B alnerazsaan

Right-click the page, on which
you placed IAG, and select "View
Code Editor” from the multiview
explorer of NA project to display
the code editor of page
subroutine.

Write the programs as shown on 11 =Sub TabPageChange
the right to the page subroutine. 12| Selectiapeangs

13 Case 0
14 HMI_IAG_Axis_Status.Function_Flg = 1 'Absolute Positioning
*In this example, variable is 15 Case 1
“PageChange". In actual 16 HMI_IAG_Axis_Status.Function_Flg = 3 'Homing
. . 17 End Select
operation, use the variable that 18t | B S
you set for “TabControl” variables
in Properties.

Select the tab control object, in
which you placed IAG, and
select "Event and Action” from
Toolbar.

Select “SelectionChanged” for Events and Actions
Events and set the subroutine TabControl0
name of ” CallSubrutine ” action
to "TabPageChange” that you
implemented in step 2. v [0] SelectionChanged @&

¥ Events < Select Event to Add ~

¥ Actions < Select Action to Add ~

v [0] CallSubroutine a

LG ENETE TabPageChange
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Select the page, on which you
placed IAG, and select "Event
and Action” from Toolbar.

Select “ PageDisplayed ” for
Events and set the subroutine
name of ” CallSubrutine ” action
to "TabPageChange” that you
implemented in step 2.

Events and Actions

MC_Test
¥ Events < Select Event to Add :

v [0] PageDisplayed

¥ Actions < Select Action to Add

“

» [0] CallSubroutine("Call

v [1] CallSubroutine

TabPageChange
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